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ABOUT THIS MANUAL
The following symbols are used in this guide:

This symbol indicates a CAUTION. Cautions warn against actions that can cause 
damage to equipment. Please read these carefully.

This symbol indicates a WARNING. Warnings alert you to actions that can cause 
personal injury or pose a physical threat. Please read these carefully.

NOTES and TIPS contain helpful information.

Fig. 1 The camera is mounted on your inverted microscope and connected to your 
computer.
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INTRODUCTION
The SI-H Optical Sarcomere Spacing System includes a high speed microscope 
camera, the software necessary to measure and monitor the changing images and 
record data. It is designed for use with the SI-CTS Cell Tester, although a Cell Tester 
is not required for the Optical Sarcomere Spacing System to run. The microscope 
camera, with a maximum frame rate of 400 fps, mounts on your inverted microscope 
above the Cell Tester (if you use one). The video images of the cell are fed into 
the software for analysis. The software is based on the NIH open source,  freeware 
“mManager.” 

A custom plugin allows the software to monitor sarcomere length. With the plugin, you 
may:

• Measure sarcomere spacing

• Run sarcomere calculations of 400Hz in the region of interest

• When used with a Cell Tester, record analog signal proportional to sarcomere 
length, and  muscle parameters like force

Parts List
After unpacking, verify that there is no visible damage to the sensor. Verify that all 
items are included:
(1) USB3 Camera
(1) 2µm Grating for calibration
(1) Software Installation CD
(1) Instruction Manual

Unpacking
Upon receipt of this instrument, make a thorough inspection of the contents and 
check for possible damage. Missing cartons or obvious damage to cartons should be 
noted on the delivery receipt before signing. Concealed damage should be reported 
at once to the carrier and an inspection requested. Please read the section entitled 
“Claims and Returns” on page 23 of this manual. Please contact WPI Customer 
Service if any parts are missing at 941.371.1003 or customerservice@wpiinc.com.

Returns: Do not return any goods to WPI without obtaining prior approval (RMA 
# required) and instructions from WPI’s Returns Department. Goods returned 
(unauthorized) by collect freight may be refused. If a return shipment is necessary, 
use the original container, if possible. If the original container is not available, use a 
suitable substitute that is rigid and of adequate size. Wrap the instrument in paper or 
plastic surrounded with at least 100mm (four inches) of shock absorbing material. For 
further details, please read the section entitled “Claims and Returns” on page 23 of 
this manual.
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SYSTEM SETUP

Installing the Software
The WPI system uses the NIH open source µManager program with a custom 
Sarcomere Detection plugin that is built for the USB3.0 camera. Before setting up the 
system, install the software. 

NOTE: Before you can sucessfully install the software, you must install the JAVA JDK 
for your operating system. Two files are included on your installation disk. Double click 
jdk-8u5-windows-j586.exe to install the 32-bit version or jdk-8u5-windows-x64.exe to 
install the 64-bit version. 

1. Place the install CD into the CD drive on your computer. If the program does not 
launch automatically, use Windows Explorer to navigate to the CD drive. Double 
click the installation file Installer.jar (Fig. 2). The install program launches (Fig. 3), 
and all the necessary support programs will be installed, including:
• WPI specific camera driver for 32-bit or 64-bit systems
• µManager Environment support file
• Sarcomere Detection plugin for µManager.

Fig. 2 Double click on the Installer file to initiate the installation process.

2. Choose 32-Bit or 64-Bit from the drop down list, based on the operating system 

of your computer. Click . The Camera Installer appears (Fig. 4).

Fig. 3 Choose 32-bit or 64-bit, based on your Operating System.

3. To install the camera software, click . The Camera Install Shield Wizard 
opens. Follow the instruction on screen. When the camera software installation 
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is finished, close the wizard.  Click  on the Sarcomere Detection plugin 
Installer window. The µManger Software Installer appears (Fig. 5).

Fig. 4 Click Install to open the camera software installation wizard.

4. To install the µManager software, click   and follow the instructions on 
screen. For best results, do not change the default installation directory. When 
the installation is complete, µManager opens. Close the µManager program. 

Then, click  on the Sarcomere Detection Plugin Installer window. The 
Sarcomere Detection Plugin installer appears (Fig. 6).

Fig. 5 Click Install to begin the installation of the µManager Software and WPI driver 
for µManager.

5. To install of the Sarcomere Detection plugin, including the WPI camera driver for 
µManager, choose the path for the location where the plugin will be installed. This 
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location should be the same place where µManager is installed. Click . 
Then, confirm the installation path. When the Sarcomere Detection plugin files are 
installed in the designated location, a confirmation message appears.

Fig. 6 When the installation of the Sarcomere Detection plugin is complete, a message 
appears.

6. Click .

Configuring µManager for the USB 3.0 Camera
To use the camera in the µManager environment, you must configure the camera. 

1. To configure your camera, plug the camera into a USB 3.0 port on your computer. 
Then, open the µManager program. The µManager Startup Configuration window 
opens (Fig. 7).

 2. If you have already configured a camera, you may select it from the drop down 
list. Otherwise, chose (none) to configure a new camera (Fig. 7).
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Fig. 7 (Left) µManager Startup Configuration window
Fig. 8 (Right) Access the Hardware Configuration Wizard from the Tools menu.

3. On the µManager main window menu bar, select the Tools menu and choose 
Hardware Configuration Wizard to open the camera configuration (Fig. 8). The 
Hardware Configuration Wizard opens. 

4. Choose the Create New Configuration radio button and click  (Fig. 9). A 
list of available devices appears.

Fig. 9 First select the Create new configuration radio button.

5. To add the camera, search for the SenTechCam folder in the list of Avail-
able Devices. Open the folder and select DCam|Sentech camera (Fig. 10). Click 

. 
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Fig. 10 Choose the SenTech camera from the list of available devices.

6. Give the device a name by entering a description into the Label field. Press 

.

7. If the DCam was successfully added, it should be listed in the Installed Devices list 
in the upper left corner. Click  to finish the configuration. Complete 
the configuration by using the default values for steps 3–6.

Fig. 11 The USB3 camera is listed in the Installed Devices section.

NOTE: For information on displaying and acquiring images, see the µManager 
instruction manual.
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Product Activation of Sarcomere Length Detection
WPI developed the custom plugin for use with the USB 3.0 camera to measure 
sarcomere length using µManager. When you launch the Sarcomere Detection plugin 
for the first time, you are asked to activate the product to register your system.

Fig. 12 Product activation is required

1. To register your product press . The Product Registration and Activa-
tion window opens (Fig. 13). 

Fig. 13 The Product Registration and Activation window appears.

2. Enter your WPI serial number for the product. Press  to validate the 
serial number. If the serial number is valid, a message appears under the serial 
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number field. A valid Serial number generates a Request Activation Code. Copy the 
code and send it to WPI at techsupport@wpiinc.com to obtain a product key. 

3. When you receive your product key, enter it into the Activate Product field and 

press  . A confirmation message appears indicating that your soft-
ware was activated. Then, the Sarcomere Detection plugin is ready for use.

Fig. 14 The confirmation window indicates that the plugin is now activated.

OPERATING INSTRUCTIONS

Quick Start with µManager
NOTE: Please refer to the µManager Instruction Manual for complete direction on the 
use of µManager. This section is included as a brief overview of using µManager with 
your USB 3.0 camera.

1. Change the Exposure time from 10ms to 0.1ms.

 
Fig. 15 Use these µManager settings when using the USB 3.0 camera.
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2. Click on the  button to show your live image from the USB 3.0 
camera. The Snap/Live window appears (Fig. 16).

Fig. 16 The live viewing window of the USB 3.0 camera indicates the frame rate (fps). 
Here the ROI size of 1296x972 leads to 376.7 fps.

3. To increase the fps, change your ROI size in the live image. To do this, select  
in the ImageJ window, and then select your desired ROI in the live window. Click 

on  to activate your selection. Watch as the frame rate changes depending 
on your ROI size. 

 NOTE: Imaging speeds greater than 1000 fps can be obtained depending on your 
ROI size.

Using Sarcomere Detection Plugin with ImageJ
When µManager opens, two main windows appears: 
• µManager Main Window–This is useful for running the camera 
• ImageJ main window–The Sarcomere Detection plugin for µManager was 

installed for image processing. You may access the Sarcomere Detection plugin 
within ImageJ by selecting the Plugins menu and choosing Sarcomere Detection 
(Fig. 17). This brings up the most recently installed version of the Sarcomere 
Detection plugin. 

NOTE: For information on using ImageJ, refer to the ImageJ manual.
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Fig. 17 You can access the Sarcomere Detection Plugin from the ImageJ main window.

1. To initiate sarcomere detection, open a sarcomere file (photo or film) or run 
µManager for live detection of sarcomeres. Choose a region of interest (ROI) where 
you can easily distinguish the sarcomere striation (light/dark fields). A region of 
interest length of 10-15 sarcomeres is a reasonable field width. This can be seen in 
the Intensity/Sarcomere Length Chart when the Sarcomere Detection plugin is open 
(Fig. 22).

Fig. 18 The ImageJ display of a sarcomere picture was captured with µManager. The 
yellow rectangle indicates the chosen region of interest. Image courtesy of Dr. Michael 
Kohlhaas, Universitäts Klinikum des Saarlandes, Homburg/Saar.

TIP: Always open your image in ImageJ and select your region of interest before 
opening the Sarcomere Detection software. Close the plugin before opening a 
different image.

2. To access the Sarcomere Detection software select the Plugins menu from the 
ImageJ main window menu bar, and choose Sarcomere Detection. The Sarcomere 
Detection software opens (Fig. 22).

3. Set up the parameters for the plugin and choose the filters you wish to use. See 
“Adjusting Plugin Parameters” on page 16.

TIP: The FFT Image J filter is more stable for contracting muscle cells. 

4. When you finish working with an image, close the plugin before you open another 
image.
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Calibrating the Objective
Before you begin making sarcomere measurements, you must calibrate your 
microscope eyepiece. 

1. Place the 2µm WPI grating (included) on your inverted microscope. 

2. Open the image in µManager. For the most accurate calibration measurment, 
zoom out to make the image as large as possible. Rotate the camera so that the 
grating lines are nearly vertical.

3. On ImageJ menu bar, select the straight line option from the angle tool ( ). 
Draw a horizontal line across your grating. 

Fig. 19 On the ImageJ window, the Straight Line option of the Angle Tool is selected.

4. Count the grating lines that the ImageJ line crosses. The grating has a spacing of 
500 grating lines/mm. So, the grating lines have af 2µm spacing. In Fig. 20, we see 
11 grating lines. For accurate calibration there should be at least 10 grating lines. 

For more information, press  on the Set Scale window (Fig. 21).

 
Fig. 20 Draw a line in ImageJ across the field of view of the 2µm grating that covers at 
least 10 grating lines.

5. In ImageJ, select Set Scale from the Analyze menu to calculate the scaling factor. 
The Set Scale window appears. ImageJ automatically enters into the Distance in 
pixels field the distance measurement (in pixels) of the straight line that you drew.
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Fig. 21 The Set Scale window is used to calculate the scaling factor. In this example, 
the known distance is 22µm, and the scaling factor is 11.636 pixels/µm.

6. Since the drawn line crosses 11 2µm grating lines, we know that the line we drew 
actually measures 22µm. Enter the actual length of the drawn line into the Known 
Distance field. The calculated scale factor is displayed at the bottom of the Set 
Scale window (11.636 pixels/µm).

NOTE: If you change the objective during sarcomere measurements, you will need to 
recalculate the scale factor, because the eyepiece calibration will change.

7. When you are setting the Sarcomere Detection Plugin parameters, enter this 
scaling factor into the Scale (pixels/µm) field of the Setup Sarcomere Detection 
window (Fig. 25).
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Sarcomere Detection Window
This window shows the region of interest, an intensity chart and a sarcomere length 
chart. It also has four buttons for controlling the program.

Region of Interest

Operation Buttons

Intensity/Sarcomere
Length Chart

DFT Filter Range
Slider

Sarcomere Length/
Time Chart

Fig. 22 The Sarcomere Detection plugin shows the region of interest, the intensity chart 
and a graph of the sarcomere length v. time.
Region of Interest–The upper image is the display of the highligted region of 
interest. This image is used to run the calculation of the sarcomere length.

/  –Use this button to start or stop the 
sarcomere length measuring. The button automatically toggles between Start and Stop.

 –Use this button to access the setup parameters for the plugin.

 –Press this button to save the measured sarcomere length data. Pressing 
this button also resets the time buffer for saving data. 

 – Press this button to clear the buffer so that new data may be acquired.
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NOTE: Before you save data or delete the buffer, stop the data acquisition.
DFT Filter Range Slider–When the DFT filter is engaged, this slider Is used to filter 
high and low frequencies. See “DFT” on page 20.
Intensity/Sarcomere Length Chart–The chart in the middle of the window displays 
the sinusoidal pattern of the chosen region of interest. Here the sarcomere length 
corresponds to the region of interest length. To improve the sinusoidal pattern (the 
light/dark cycle of the sarcomere striations), adjust the filter values using the setup 
parameters. See “Filter Settings” on page 18. The optimal sinusoidal pattern is 
achieved when you see one red X for each downward inflection of the sinusoidal 
pattern. 

Fig. 23 The Intensity/Sarcomere Length Chart shows the sinusoidal pattern of the 
region of interest.

Sarcomere Length/Time Chart–The bottom chart displays the measured 
sarcomere length change over the measured time (Fig. 24). 

Fig. 24 Sarcomere length change during a 1 Hz contraction of a cardiac myocyte.
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Adjusting Plugin Parameters
Before you begin making measurements, you may adjust the plugin parameters. To do 
this you press . The Setup Sarcomere Detection window appears.

Fig. 25 Use the Setup Sarcomere Detection window to define the plugin parameters.
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/  –Press this button to toggle between static mode and 
dynamic mode. It may be useful to toggle between the modes when you switch 
from running tests on resting muscle condition (static mode) and contracting 
muscle condition (dynamic mode). If you are using a large region of interest with 
imperfections in your image, you will see better results with static mode. You can even 
use the Min and Max Sarc Length parameters to filter out these image imperfections.
Sample Period (ms)–Select your sample period (in milliseconds) from the drop down 
list. This defines the waiting period between two measurements. 
NOTE: A measurement will not begin until a previous measurement has finished. This 
could happen if the measurement takes longer than the sample period, which could 
happen if the region of interest is too large.
Lower Chart Limit (µm)–Set the minimum value in microns of the Y-axis for the 
Sarcomere Length/Time Chart. 
Upper Chart Limit (µm)–Set the maximum value in microns for the Y-axis for the 
Sarcomere Length/Time Chart. 
Time Chart Width (s)–Set the total width in seconds of the X-axis for Sarcomere 
Length/Time Chart.
Min Sarc Length (µm) – Set the minimum sarcomere boundary to be detected. A 
sarcomere length smaller than this threshold is ignored.
Max Sarc Length (µm) – Set the maximum sarcomere boundary to be detected. A 
sarcomere length larger than this threshold is ignored.
TIP: When sarcomere length is outside the range set by the minimum and maximum 
thresholds, a question mark displays for the sarcomere length on the Sarcomere 
Detection Window. To see a value, expand your detection range (Min/Max Sarc Length 
settings) or select a larger region of interest.
Scale (pixel/µm)–Set the calibrating factor to compare pixels with microns. See 
“Calibrating the Objective” on page 12.

File Path –Press this button to open the folder browser and select the location 
of your saved files. After you select the folder location, the file path appears in the text 
field. If you need to create a new folder, use Windows Explorer.
File Name–Enter the name for your new data file where the measurement data 
will be stored. If you do not change the file name here, the existing name will be 
appended with a number that increments automatically each time measurements are 
saved.
Index–This is the starting number used when the file name is automatically 
incremented. In the example image, the first file name will be sample0.
Filter Type–Filters are used for image processing, and each type has its own settings 
which are detailed later. Click on the Filter Type button to toggle between the filter 
option. The filter type options include: 

• FFT-ImageJ–This is an ImageJ based FFT image filter (page 18).
• DFT is a Discrete Fourier Transform, which filters out a selected frequency 

range (page 20).
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Measuring Start (pixel)–Set a length in pixel for the zero point. The program 
skips these pixels on the left side of the region of interest and does not make 
measurements on them.
Measuring End (pixel)–Set a length in pixels for the end point. This is an inset from 
the right side of the region of interest. Pixels within the designated border region are 
not used for measurements.

Fig. 26 This chart shows that the start point is not at the zero point (left) of the chart’s 
X-axis, and the end point is not at the far right of the chart X-axis. Each red X indicates 
that a measurement was made. In this example, measurements start around 2.5µm 
and end around 22.5µm.

Filter Settings 
NOTE: FFT ImageJ filter settings need to be activated when you are running the 
sarcomere detection.

FFT–ImageJ
This filter is used to sharpen an image by removing blur caused by things like 
movement artifacts. Two options for this filter, which are often used together, allow 
you to filter out the largest structures and/or filter out the smallest structures. When 

you select the FFT-ImageJ filter type, the  button appears. Click the 
button to open the FFT Bandpass Filter window (Fig. 28) and set your parameters for 

the filter. After you set your parameters, click . For more information on this 
filter type, press .

Fig. 27 When the FFT ImageJ filter type is selected, the Filter Setting button appears.
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Fig. 28 Use this window to establish the parameters for your filter.

Filter Large Structures Down to–Enter a number of pixels here. Structures 
comprised of more pixels than this threshold are filtered. This filter corresponds with 
the suppression of low frequencies in the image. It is typically chosen to filter out 
smooth variations like movement artifacts in the background. Values greater than the 
chosen filter value are suppressed. To suppress movement artifacts, increase this 
filter value.

Filter Small Structures Up to–Enter a number of pixels here. Structures comprised 
of fewer pixels than this threshold are filtered. This filter corresponds with the 
suppression of high frequencies in the image and determines the amount of 
smoothing. Objects in the image smaller than this size are strongly attenuated. To 
remove movement artifacts increase the filter value. Resting sharp peak values in the 
image are also filtered out by increasing this value. 

NOTE: Increasing the region of interest size/width may improve the detection quality.

Suppress Stripes–Use this drop down list to choose whether or not to eliminate 
horizontal or vertical stripes.

Tolerance of Direction–If you use Suppress Stipes, you may set a tolerance value. 
Higher values remove shorter stripes and stripes that are running under an angle with 
respect to the chosen direction (horizontal or vertical).

Autoscale after Filtering–By selecting this checkbox, you turn on autoscaling. The 
lowest intensity is set to 0, and the highest intensity is set to 255.

Saturate image when Autoscaling allows some intensities to go into saturation 
and produces a better visual contrast. Saturate will only produce an effect when 
autoscaling is enabled.

Display Filter shows the filter that is generated.
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DFT
The DFT (Discrete Fourier Transform) filter allows you to filter low and high frequencies 
in the image during the sarcomere length measurement. To activate this filter, select 
DFT as the filter type in the Setup Sarcomere Detection window. When you close the 
Setup Sarcomere Detection window, the filter is active.

Fig. 29 Select the DFT filter type to activate the range sliders on the main plugin 
window.

1. Press  on the main plugin window to begin capturing data.

2. Select the filter frequencies by simply moving the range sliders (Fig. 30). The blue 
slider (left side) can be used to filter low frequencies, and the red slider (right side) 
can be used to filter high frequencies. Move the slider to optimize the sinusoidal 
pattern in the Intensity/Sarcomere Length chart. 

NOTE: The slider values are visible in the main Sarcomere Detection window. See Fig. 
22.

TIP: Move the blue slider (left) to filter out the DC component of the image. Then, 
move the red slider (right) so that it is close to the blue one. Move the sliders as 
needed to obtain the best sinusoidal pattern.This filter works best when the sinusoidal 
pattern is most apparent. The pattern will also depend on your region of interest. 
Selecting a larger region of interest may require more patience in adjusting this filter.

Fig. 30 Sinusoidal pattern with the range slider to select the frequencies to be filtered 
(blue point low frequencies are filtered out; red point high frequencies are filtered out).

TIP: Position the blue and red sliders close together for the most stable results (±4nm) 
when measuring sarcomeres in the 2µm range.
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TROUBLESHOOTING
Issue Possible Cause Solution

Pr
og

ra
m

 w
ill

 
no

t z
oo

m
 o

ut
.

Only the ROI from the previ-
ous is visible, because it wasn’t 
closed properly.

Open the SI-SARCAM-CTS software. 
There should be an icon on your desktop. 
Choose the Options menu and select Set-
tings. When the Settings window opens. 
Press the Reset button. 
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No ROI was selected before 
starting the plugin.

Before making any measurements, you 
must load an image, a video or the live 
camera field of view and select a region of 
interest. Then you can start the Sarco-
mere Detection software.

Th
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tim
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ne
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tiv

e 
va

lu
es Occassionally, you may see nega-

tive numbers or spikes on the 
sarcomere length graph.

Close and restart µManager.

NOTE: If you have a problem/issue that falls outside the definitions of this 
troubleshooting section, contact the WPI Technical Support team at 941.371.1003 or 
technicalsupport@wpiinc.com.

SPECIFICATIONS
This unit conforms to the following specifications:
Camera 5MP, monochromatic, USB3, up to 400fps

mManager* developed at Vale laboratory at UCSF, funded by an NIH grant R01-EB007187 
from the National Institute of Biomedical Imaging and Bioengineering (NBIB)
*Arthur Edelstein, Nenad Amodaj, Karl Hoover, Ron Vale, and Nico Stuurman (2010), Computer Control of Microscopes Using 
μManager. Current Protocols in Molecular Biology 14.20.1-14.20.17 
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* Electrodes, batteries and other consumable parts are warranted for 30 days only from the date on which 
the customer receives these items.

WARRANTY
WPI (World Precision Instruments, Inc.) warrants to the original purchaser that this equipment, including 
its components and parts, shall be free from defects in material and workmanship for a period of 
30 days* from the date of receipt. WPI’s obligation under this warranty shall be limited to repair or 
replacement, at WPI’s option, of the equipment or defective components or parts upon receipt thereof 
f.o.b. WPI, Sarasota, Florida U.S.A. Return of a repaired instrument shall be f.o.b. Sarasota.

The above warranty is contingent upon normal usage and does not cover products which have been 
modified without WPI’s approval or which have been subjected to unusual physical or electrical stress 
or on which the original identification marks have been removed or altered. The above warranty will not 
apply if adjustment, repair or parts replacement is required because of accident, neglect, misuse, failure 
of electric power, air conditioning, humidity control, or causes other than normal and ordinary usage.

To the extent that any of its equipment is furnished by a manufacturer other than WPI, the foregoing 
warranty shall be applicable only to the extent of the warranty furnished by such other manufacturer. 
This warranty will not apply to appearance terms, such as knobs, handles, dials or the like.

WPI makes no warranty of any kind, express or implied or statutory, including without limitation any 
warranties of merchantability and/or fitness for a particular purpose. WPI shall not be liable for any 
damages, whether direct, indirect, special or consequential arising from a failure of this product to 
operate in the manner desired by the user. WPI shall not be liable for any damage to data or property 
that may be caused directly or indirectly by use of this product.

Claims and Returns
Inspect all shipments upon receipt. Missing cartons or obvious damage to cartons should be noted on 
the delivery receipt before signing. Concealed loss or damage should be reported at once to the carrier 
and an inspection requested. All claims for shortage or damage must be made within ten (10) days 
after receipt of shipment. Claims for lost shipments must be made within thirty (30) days of receipt of 
invoice or other notification of shipment. Please save damaged or pilfered cartons until claim is settled. 
In some instances, photographic documentation may be required. Some items are time-sensitive; WPI 
assumes no extended warranty or any liability for use beyond the date specified on the container

Do not return any goods to us without obtaining prior approval and instructions from our Returns 
Department. Goods returned (unauthorized) by collect freight may be refused. Goods accepted for 
restocking will be exchanged or credited to your WPI account. Goods returned which were ordered 
by customers in error are subject to a 25% restocking charge. Equipment which was built as a special 
order cannot be returned.

Repairs
Contact our Customer Service Department for assistance in the repair of apparatus. Do not return 
goods until instructions have been received. Returned items must be securely packed to prevent 
further damage in transit. The Customer is responsible for paying shipping expenses, including 
adequate insurance on all items returned for repairs. Identification of the item(s) by model number, 
name, as well as complete description of the difficulties experienced should be written on the repair 
purchase order and on a tag attached to the item.
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